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INTRODUCTION TO EPI INFO™ 7 

Epi Info™ is a public domain suite of software tools designed for the global community of 

public health practitioners. It allows the easy creation of electronic forms, rapid data entry 

into those forms, and analysis of the data with epidemiologic statistics, maps, and graphs. Since 1985, the 

Centers for Disease Control and Prevention (CDC) has been developing and maintaining Epi Info™. 

As public domain software, Epi Info™ is free to download, use, and distribute without restriction. The latest 

version of Epi Info™ may be obtained at http://www.cdc.gov/epiinfo. 

This guide is designed to introduce you to the core concepts of each of the main modules in Epi Info™ 7. 

We’ll start with creating a basic data entry form for a fictional outbreak of E. Coli, enter data into that form, 

and discuss some of the basics of data analysis. 

EPI INFO™ RESOURCES 

Training documentation, translations, technical information, and other resources are available on the Epi 

Info™ website at http://www.cdc.gov/epiinfo. If you have any questions or problems using the software, or 

want more information, you can e-mail the Epi Info™ help desk at epiinfo@cdc.gov, or call 404.498.6190. 

An Epi Info™ Internet forum was recently created at http://www.phconnect.org/group/epiinfo. Users 

around the world can ask each other questions and solicit advice.  
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DOWNLOADING AND SETUP 

Epi Info™ 7 can be downloaded from http://wwwn.cdc.gov/epiinfo/7/index.htm. Two 

versions of the software are available: A “zip” 

file and a traditional “setup” file. “ZIP” files are also known as 

archive or compressed files. These files should open on any 

Windows computer, though different applications may be 

used to open them depending on the computer’s system 

configuration. This guide will walk you through using the 

Windows 7 archive file viewer to extract the files. 

The “setup” file works like a traditional installer and simply 

needs to be run (or executed) to install Epi Info 7. You may 

not, however, be able to use the “setup” file if you do not have administrative rights or elevated privileges 

on your computer. 

EXTRACTING THE ARCHIVE 

1. Open your web browser and navigate to http://wwwn.cdc.gov/epiinfo/7/index.htm. 

2. Click the Epi Info™ 7 (zip) link from the download section. A prompt will appear asking if the file 

should be saved or opened. 

 
Figure 1.1: Downloading Epi Info 7 in “zip” format. 

 

Note: An archive file is a container that can 

store other files. Because the Epi Info™ 7 

software is composed of many individual 

files, it is not practical for you to download 

each file individually. All files needed to run 

Epi Info™ 7 are placed into a single 

container file. 
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3. Click the Open button (or the Run button depending on the web browser). In a few moments, the 

file will open (Figure 1.2). 

 
Figure 1.2: The Epi Info 7 “zip” file after being opened in Windows 7. 

 

 

 

 

 

 

 

 

 

 

4. Select the contents of the archive and drag them onto the desktop (Figure 1.3). This will copy the 

Epi Info™ 7 program files to the desktop. After completion, a pair of icons will appear on your 

desktop (Figure 1.4). 

Note: Some computers may open 

the “zip” file in a different program 

(e.g., WinZip or WinRAR). The 

instructions provided here assume 

that the file has been opened using 

Windows Explorer. 
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Figure 1.3: Selecting the contents of the folder and dragging them onto the computer’s desktop. 

 
Figure 1.4: The desktop after completing Step 5. 

 

5. After completing Step 4, double-click on the Launch Epi Info 7 icon. Epi Info™ 7 launches. 
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CREATING A FORM 

To collect data, first create a data entry form. If you recall from the introduction, we’ll be 

creating a food history questionnaire for a fictional outbreak of E. Coli. To create our 

questionnaire, we’ll use the Form Designer module. The Form Designer is accessed through the Epi Info™ 7 

menu. You can open the menu by clicking on the Epi Info™ icon on your desktop (Step 5 in Part One of 

this guide).  

Forms in Epi Info™ 7 consist of one or more pages. Each page may have one or more fields. There is no limit 

to the number of pages or fields on an Epi Info™ 7 form.  

OPENING THE FORM DESIGNER 

1. Navigate to the desktop. 

2. Double-click on the Launch Epi Info™ shortcut. The Epi Info™ 7 menu will appear (Figure 2.1). 

 
Figure 2.1: The Epi Info™ 7 menu. 

 

3. Since we want to create a simple data entry form, click the Create Forms button. The Form 

Designer will appear (Figure 2.2). 

3 
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Figure 2.2: The Epi Info™ 7 Form Designer, where forms are created and edited. 

CREATING YOUR FIRST PROJECT 

After opening the form designer, you’ll notice that many of the options are grayed out. These options are 

disabled because you have not created a new Epi Info™ project or opened an existing project for editing.  

Similar to DOC and DOCX files being the standard file formats for Microsoft Word, Epi Info™ Project Files 

are the standard file formats for Epi Info™. Think of the project like a container for all of the components 

you will need to carry out your data collection and analysis. 

Before we can begin adding questions to our food history questionnaire, first create a new project: 

1. From the toolbar, click the New Project button. The New Project window will appear. 

2. In the Name field, type EColi_Sample_2012. This will become the project’s name. 

3. In the Form Name field, type FoodHistory. This will become the name of the first form contained 

within the project. 

4. Click OK. After several seconds, the project is created and a blank canvas will appear in the Form 

Designer window. 
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Figure 2.3: The Epi Info™ 7 Form Designer after creating a new project. 

Congratulations, you’ve created your first Epi Info™ project! You’re now ready to create fields and decide 

how those fields should appear.  

Before proceeding, take a minute and observe the Project Explorer panel (the left-hand side of the screen in 

Figure 2.3). Notice the tree-like structure of objects. The project we created appears as the root item, in this 

case, EColi_Sample_2012. The name of our form, FoodHistory, appears underneath it. Items can be 

expanded or collapsed using the + and – icons to the left of the item’s name. 
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CREATING FIELDS 

ADDING A TEXT FIELD 

Every time you create a new project, a default form is added to 

it. In the steps you completed above, this default form was called 

FoodHistory and is being displayed in the Form Designer 

window, ready to be edited. The next steps, outlined below, add 

fields to the form. We’ll first add a Text field.   

1. With the FoodHistory form loaded (Figure 2.3), right-

click on the canvas. A pop-up menu will appear (Figure 2.4). 

 
Figure 2.4: The pop-up menu when right-clicking on the canvas. 

 

2. Move the mouse over the New Field option. A sub-menu will appear (Figure 2.5). 

Note: Text fields allow you to type in 

whatever values they want and are best 

used for open-ended questions (e.g., street 

address and name). 
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Figure 2.5: The list of field types that you can add to your form 

 

3. From the list of choices, select Text. A Text dialog will appear (Figure 2.6). 

 
Figure 2.6: The field definition dialog box for Text fields. 

 

4. In the Question or Prompt field, type Last Name. 

5. Press the TAB key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt. 
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Figure 2.7: The field definition dialog box for after completing Step 5. 

 

6. Click OK. The field is created and displayed on the canvas. 

At the most basic level, that’s all there is to adding fields – simply select the type of field you want to add 

and give it a prompt. 

The steps above outlined how to create a text field. Other field types are also available, including number 

fields (which restrict you to entering valid numbers), date fields, checkboxes, and drop-down lists. Let’s add 

several more fields. 

ADDING A NUMERIC FIELD 

With a text field, you can type in whatever values you want. This makes them unsuitable for collecting 

certain types of data (e.g., a patient’s age or temperature at the time of the interview). A numeric field 

ensures that only valid numbers are accepted, which can be helpful later during analysis if you want to 

generate a mean, median, mode, min/max values, etc. 

1. Right-click on the canvas. A pop-up menu will appear. 

2. Move the mouse over the New Field option. A sub-menu will appear (Figure 2.5). 

3. From the list of choices, select Number. A Number dialog will appear (Figure 2.6). 

4. In the Question or Prompt field, type Age. 

5. Press the TAB key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt. 

6. In the Pattern drop-down list, select ##. The ## option will force you to enter only two digits. 

7. Check the Range box. Notice how the Upper and Lower boxes activate. 

8. Type 5 for the lower value, and 80 for the upper value. 
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Figure 2.8: The field definition dialog box as it should look after Step 8. 

 

9. Click OK. The Age field is created and displayed on the canvas. 

FIELD PROPERTIES 

Notice that the Field Definition window for the numeric field was different than it was for the text field.  

The text field did not include options to set a range or define any kind of pattern. Each field type has its 

own distinctive set of options available for customizing the field’s appearance and behavior. 

Some of the more commonly-seen properties include: 

1. Range - Allows the designer to specify upper and lower values for the field. Any data falling outside 

of the upper and lower boundaries of the range property will be discarded. 

2. Required - Must be filled in before the record can be saved.  

3. Read only - May not be modified by the user. It is generally useful only to more advanced users. 

ADDING A CHECKBOX 

Text and Numeric field types allow you to enter open-ended data and may not always be useful in all 

scenarios. If we want to collect data on whether the patient was ill, we could use a checkbox field instead. A 

checkbox is either checked or unchecked and can never be set to any other value. It is well-suited for 

questions where the only answers are either yes or no. 

1. To add a new field, right-click on the canvas. 

2. From the list of choices, select Checkbox. A Checkbox dialog will appear (Figure 2.6). 

3. In the Question or Prompt field, type Ill. 
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4. Press the Tab key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt. 

 
Figure 2.9: The field definition dialog box as it should look after Step 4. 

 

5. Click OK. The Ill field is created and displayed on the canvas. 

ADDING A YES/NO FIELD 

You might wonder what the point of a Yes/No field is when 

there is already a Checkbox field type. It is true that Yes/No 

and Checkbox fields store the same type of data, but there is 

one very important difference: Yes/No fields can be cleared, 

meaning they can hold a blank or “missing” value in addition 

to Yes or No. For our next field, collect data on whether the 

patient is pregnant.  

1. To add a new field, right-click on the canvas. 

2. From the list of choices, select Yes/No. A Yes/No 

dialog will appear. 

3. In the Question or Prompt field, type Is Pregnant?  

4. Press the TAB key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt. Also notice how the space between Is and Pregnant and the question mark 

was removed; neither spaces nor question marks are valid field names. 

5. Click OK. The field is created and displayed on the canvas. 

After the Yes/No field has been created, it will appear as a drop-down list on the form. Because this is the 

form designer module (and not the data entry module), you will not be able to choose any of the values. 

Tip: Yes/No fields are best suited for 

questions where “Yes” and “No” are the 

desired answers, but where you want the 

data enterer to be able to leave the question 

blank. Note that a checkbox field can never 

be blank. 
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ADDING A DROP-DOWN LIST OF VALUES 

The Yes/No field is an excellent choice for questions where the only possible values are yes, no, and 

unknown. What if we want to present a drop-down list of choices to the user, where we have defined our 

own list of possible values? Epi Info 7 provides three field types with which to do this: Legal Values, 

Comment Legal, and Codes. The simplest of these options is the Legal Values field type, which we will 

create in the steps below. 

Let’s create a drop-down list of choices for gender: 

1. To add a new field, right-click on the canvas. 

2. From the list of choices, select Legal Values. A Legal Values dialog will appear. 

 
Figure 2.10: The Legal values field definition dialog after completing Step 4. 

 

3. In the Question or Prompt field, type Gender. 

4. Press the Tab key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt.  

5. Click the Ellipsis button next to the Data Source text box (shown highlighted in Figure 2.10). The 

Set Up Code / Legal Links dialog will appear (Figure 2.11). 
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Figure 2.11: The Set Up Code / Legal Links dialog. 

 

6. Click Create New to create a new list of values for this field. The dialog should change in 

appearance (Figure 2.12). 

 
Figure 2.12: The Set Up Code / Legal Links dialog. 

 

7. In the first row, type Female . 

8. In the second row, type Male (Figure 2.13). 
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Figure 2.13: The Set Up Code / Legal Links dialog after completing Step 7. 

 

9. Click OK. The Legal Values field definition dialog should re-appear. 

10. Click OK. The field is created and displayed on the canvas (Figure 2.12). 

 

Figure 2.14: The drop-down list of values, as shown on the canvas, after completing Step 9. 

 

Figure 2.15: The form as it should look after completing Step 9. 
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FIELD PLACEMENT 

You should now have five fields on your page: A text box for 

Last Name, a numeric field for Age, a checkbox for whether 

the patient is ill, a yes/no field for whether the patient is 

pregnant, and a drop-down list for gender. If you haven’t 

done anything else, the fields will probably look poorly placed 

and unprofessional. 

To move a field: 

1. Place the mouse cursor on the Last Name field’s 

prompt text. 

2. Press and hold the left mouse button. 

3. Move the mouse. 

Notice how the entire field, along with the prompt, moves with the mouse. 

You can also move the input box for a field separately from its prompt. To do this: 

1. Place the mouse cursor on the Last Name field’s input box. 

2. Press and hold the left mouse button. 

3. Move the mouse. 

You can set the prompt independently of the input box. If you decide you don’t like how a field’s input box 

is positioned relative to its prompt, you can always set it back to its default using the following steps: 

1. Right-click on the field. A pop-up menu will appear 

2. From the list of choices, select Default Prompt Align. 

FIELD ALIGNMENT 

Moving fields is one method of making your form look more professional. However, it can be tedious and 

time-consuming, especially if many fields are required. Epi Info™ has a field alignment feature that can help 

make this process faster: 

1. Place the mouse cursor very close to the top-left corner of the canvas. 

2. Press the left mouse button and hold it. 

3. Move the mouse to the lower right-hand corner of the screen. Notice how a blue lasso is drawn as 

the cursor changes position. 

Note: If you observe that the fields are 

‘snapping’ into position and don’t always go 

exactly where you want, this is a feature 

called Snap to Grid. It can be turned off by 

navigating to the Format menu and 

selecting Grid Settings. 
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Figure 2.16: The ‘lasso’ 

 

4. Ensure that all of the fields you have created fall within the blue lasso (Figure 2.16) and release the 

left mouse button. The fields should all appear as if they have been selected (Figure 2.17). 

 
Figure 2.17: All of the fields selected. 

 

5. Navigate to the Format menu item. 

6. Select Alignment > Stack (Figure 2.18). 
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Figure 2.18: The alignment options. 

 
Figure 2.19: The fields after being aligned in ‘stack’ mode. 

 

The fields are now aligned vertically on the screen (Figure 2.19). 
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OTHER FEATURES 

UNDO AND REDO 

Assuming you didn’t actually mean to align the fields now, Epi Info™ 7 provides a way to undo your most 

recent changes. 

1. Press CTRL+Z on the keyboard. 

2. Or press the Undo button on the toolbar.  

Notice how one of the fields snaps back to its original position. If you keep selecting Undo, the Form 

Designer will eventually revert all of the fields back to their original positions. If you go far enough, you can 

even undo the creation of those fields. 

If you decide that you want to redo an action that you previously un-did, you can use the redo option.  

1. Press CTRL+Y. 

2. Or press the Redo button on the toolbar.  

ADDING AND REMOVING PAGES 

Sometimes, a single page is not nearly enough space to hold all of the fields for a single survey. You can 

quickly add or insert pages if you need additional space. Let’s add a second page: 

1. In the Project Explorer pane on the left-hand side of the screen, right-click the item called 

FoodHistory. A pop-up menu will appear. (FoodHistory is the name of the form we created 

earlier). 

2. Select Add Page. A Page Name window should appear. 

3. Leave the page name as its default of Page 2. Click OK. The second page is created and loaded onto 

the canvas. 

You can navigate back and forth between pages by clicking on the page name in the Project Explorer.  A 

page can be deleted by right-clicking on it and selecting Delete Page. 

ADDING TEMPLATES 

Some fields (i.e, Name, Age, Date of Birth, Address), may be fairly common among various forms that you 

design. Epi Info™ 7 includes a feature by which you can save one or more fields as a template to re-use those 

fields in other forms. 

In the example below, we will add a template to Page 2. The Epi Info™ 7 development team has already 

included it with Epi Info™ 7, so we don’t need to create it. 

1. In the Project Explorer, click Page 2 of the FoodHistory form. 

2. Next to Templates, click the + icon. A new item called Standard should appear in the tree list. 

3. Click the “+” icon next to Standard in the Project Explorer. Four new items should appear in the 

tree list. 
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Figure 2.20: The Templates item, expanded. 

 

4. Highlight Demographics (Figure 2.20) and drag it onto the canvas. After about 10 seconds, the 

demographics fields will appear (Figure 2.21). 

 

Figure 2.21: The Demographics template. 

Adding the demographics template was much faster than manually creating the first name, last name, sex, 

DOB, and age fields for a brand-new survey. Not all templates, however, will fit every scenario and some 

modifications will typically be needed. Once the template has been added to a form, you can modify the 

fields in manner. 

You can also define your own templates by selecting multiple fields, right-clicking on the canvas, and 

selecting Save as Template. 
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ADDING A FORM TITLE 

We probably want to place a heading or title on our questionnaire to make it obvious what it is the 

questionnaire is for. Titles can be added by creating a label field. Unlike the other fields we’ve created, label 

fields do not store any data and exist for display purposes only. Follow the steps below to add a title to the 

top of the questionnaire: 

1. In the Project Explorer pane, click on Page 1. You should be on the first page. 

2. Make space for the title at the top of the form. Rearrange the fields on the form to make sufficient 

space. You may need to re-align the fields once you are done moving them (see the Field Alignment 

section). 

3. To add a new field, right-click on the canvas. 

4. From the list of choices, select Label/Title. A Label/Title dialog will appear (Figure 2.22). 

 
Figure 2.22: The Label/Title field definition dialog after completing Step 4. 

 

5. In the Question or Prompt field, type E. Coli Food History Questionnaire. 

6. Press the Tab key. Notice how the cursor jumps to the Field Name field and automatically filled it 

in based on the prompt. 

7. Click the Font button. A Windows Font dialog appears. 

8. Change the font style to Bold.  

9. Set the size to 18. 



Epi Info™ 7 Quick Start Guide 

Page 24 

 

 
Figure 2.23: The Font dialog after completing Step 9. 

 

10. Click OK. The font is set and the Label/Title field definition dialog re-appears. 

 
Figure 2.24: The Label/Title field definition dialog after completing Step 10. 

 

11. Click OK. The field is created and displayed on the canvas. 

Labels often need to be re-sized to properly fit the screen. Re-sizing labels is important because it allows the 

use of soft line breaks and easier placement of large amounts of text. Notice how when the mouse is moved 

over the label, eight handlebars appear that allow its boundaries to be expanded or collapsed (Figure 2.25). 
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Figure 2.25: Moving the mouse over the label field. 

Changing the position of the box using the handlebars can be used to break the text into multiple lines 

(Figure 2.26). 

 

Figure 2.26: Re-sizing the title. 

After adding and manipulating the title, our food history questionnaire should look similar to Figure 2.27. 

 

Figure 2.27: The form after adding the label/title field at the top of the page. 
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WORKING WITH THE TAB ORDER 

The tab order refers to the order in which the cursor visits each field on a page as the Tab key is pressed. 

Having a tab order that does not follow the logical order of entry will make entering data cumbersome. 

However, the data entry person can override the tab order at any time by using the mouse. Epi Info™ 7 has 

several built-in options for managing the tab order which will be discussed below. 

SHOWING THE TAB ORDER 

First, let’s go back to Page 1 and look at the tab order as it exists after completing all of the prior sections: 

1. In the Project Explorer pane, click on Page 1.  

 
Figure 2.27: Page 1 of the FoodHistory form. 

 

2. Right-click on the canvas. 

3. Select Tabs > Show Tab Order (Figure 2.28). The canvas will change to look like Figure 2.29. 
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Figure 2.28: Completing step 2 above 

 

 
Figure 2.29: The canvas after completing Step 2. 

 

 

 

 

 

 

 

 

 

4. To make the black tab boxes disappear, left-click anywhere on the canvas. 

5. Add a new text field called Patient ID. Place it next to the Last Name field (Figure 2.30). 

Note: The order of entry will follow from 

the smallest to the largest number. This 

means that Last Name will be filled in first 

.Pressing TAB will take you to the Age field. 

Pressing TAB again will take you to the Ill 

field. 
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Figure 2.30: The canvas after completing Step 4. 

 

6. Display the tab order again by repeating Step 2. The black tab boxes appear (Figure 2.31). 

 

Figure 2.31: The tab order after adding Patient ID. 
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Because Patient ID was added last, it has the highest tab number, even though it appears right next to the 

Last Name field. Logically, it would make sense that the Tab key would move the cursor from Last Name to 

Patient ID but until the tab order is modified, this will not occur. Instead, the cursor will move in the 

following order: 

1. Last Name 

2. Age 

3. Ill 

4. Is Pregnant? 

5. Gender 

6. Patient ID 

AUTOMATICALLY RE-CALCULATING THE TAB ORDER 

You have  two options. First, let the Form Designer automatically re-calculate the tab order based on each 

field’s placement on the page. This will force the tabs to go in ascending order using a top-to-bottom, left-

to-right algorithm.  

To automatically re-calculate the tabs: 

1. Right-click on the canvas. 

2. Select Tabs > Start New Tab Order (Figure 2.32). In a few moments, the canvas should appear 

(Figure 2.33).  

 

Figure 2.32: Re-calculating the tab order. 
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Figure 2.33: The re-calculated tabs. 

Notice that the order has changed to ensure that Patient ID will be filled out after Last Name instead of 

after Gender. 

MANUALLY SETTING THE TAB ORDER 

There are many cases where the tab order must be set manually. For example, we may want to provide 

slight customizations to the tab order that the automatic tab re-calculation (discussed in the previous 

section) will not be able to provide. Let’s change the current order of entry for Page 1 of the FoodHistory 

form: 

1. Patient ID 

2. Last Name 

3. Gender 

4. Age 

5. Ill 

6. Is Pregnant? 

To make this change, we’ll first display the black tab boxes and click on each of them in the order you want 

the entry to occur: 

1. Right-click on the canvas. 

2. Select Tabs > Show Tab Order. The canvas will change to show black tab boxes over each field. 

3. Left-click on the black box for the Patient ID field. This sets Patient ID as the first field. 
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4. Left-click on the black box for the Last Name field. The tab number for Last Name should 

change to be one more than the value in the Patient ID field. 

5. Left-click on the black box for the Gender field.  

6. Left-click on the black box for the Age field. 

7. Left-click on the black box for the Ill field. 

8. Left-click on the black box for the Is Pregnant? field. 

The canvas should now appear (Figure 2.34). 

 

Figure 2.34: The canvas after completing Step 7. 

Notice that the lowest tab index is two. The order always flows from the lowest number to the highest, 

regardless of where the numbering starts. 

If we want to go back to the previous order, follow the steps in the Automatically Re-calculating the Tab 

Order section. 

GROUPING FIELDS 

Fields can be grouped together using the Add Group Field option. The Group Field will add a rectangular 

box around the fields it contains, and the group’s name will appear at the top. See Figure 2.35 for an 

example of a group field. 

 

Figure 2.35: An example of a group of checkbox fields. 
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In the image above, the Places Visited group field contains 17 checkbox fields. During analysis, we have the 

option of analyzing the group field as a whole instead of analyzing each of the checkbox fields separately. 

Grouped analysis can save considerable time and effort. For more information on analyzing group fields, see 

the sections below on analyzing data. 

Because we’re dealing with an outbreak of E. Coli, we probably want to collect information regarding what 

foods may have been consumed. As in the example above, we could create one checkbox for each food item 

and group the checkboxes together, making analysis of the foods eaten much simpler. 

1. Create a third page on the FoodHistory form. 

2. Add the following checkbox fields to the third page using the techniques you have learned so far: 

 

• Grapes 

• Blueberries 

• Fresh Celery 

• Tomatoes 

• Raw Carrots 

• Strawberries 

 

After the checkbox fields have been added, Page 3 of the form should look like Figure 2.36. 

 

 
Figure 2.36: The six checkbox fields after completing Step 2. 

 

3. To highlight the fields, left-click and drag a box around the six checkbox fields created in Step 2. 
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Figure 2.37: Dragging a box around the six fields. 

 

 
Figure 2.38: The six fields highlighted. 

 

4. With the fields highlighted (Figure 2.38), right-click on the canvas. 
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5. From the pop-up context menu, select New Field Group. If you do not see the New Field Group 

option in the right-click context menu, make sure you right-click on the canvas and not on any of 

the fields.  Also make sure that all six of the fields are highlighted (Figure 2.38). 

6. In the group field prompt, type Foods Eaten.  

7. To set the field’s field name, press the Tab key. 

8. Click OK. The group field is created (Figure 2.39). 

 

Figure 2.39: The group field after completing Step 7. 

The group can be re-sized and moved similar to a label field. Moving the group field also moves the fields 

within the group. Note that it may be difficult to multi-select fields inside of a group. Left-clicking and 

dragging does not work on a group field. 
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ADDING INTELLIGENCE TO FORMS – CHECK CODE 

Check Code helps validate data entry and allows data to be entered faster and more accurately. With 

advance planning, code can be created to do calculations, skip questions based on prior answers, prompt 

the user with dialog boxes, and populate fields. In its most basic form, Check Code is a set of rules for the 

person entering data to follow. It helps eliminate errors that occur when entering large amounts of 

information. 

For the purposes of this guide, we will create a very simple skip pattern 

using several of the fields we generated on the first page of the E. Coli Food 

History Questionnaire.   

CREATING A SKIP PATTERN 

To make a relevant example, first move the fields around a bit. The Gender 

field needs to appear beneath the Name field, and Is Pregnant? should 

appear directly under Gender. Use the skills you have learned in field placement to re-arrange and re-align 

the fields in such a manner. See Figure 2.40. 

 

Figure 2.40: The form as it should look prior to starting this section. 

The form must be re-arranged to look like Figure 2.40. Otherwise, the skip pattern we’re creating will not 

work. 

Note: The term “Check Code” 

originated from the desire to 

“check” the user’s input for 

accuracy and correctness. 
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Let’s start with a simple example: If the user enters Male for the Gender field, we want to move the cursor 

past the Is Pregnant? field, leaving it blank. 

1. On the Form Designer toolbar, click the Check Code button. The Check Code Editor window 

appears (Figure 2.41). 

 
Figure 2.41: The Check Code Editor window. 

 

2. You want the action, (in this case, the skipping of a field), to occur after you enter a value for the 

Gender field. You need to specify this field when creating the Check Code commands. In the 

Choose Field Block for Action pane, expand the Page 1 node (Figure 2.42). The list of fields on 

Page 1 should appear. 
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Figure 2.42:  Expanding the Page 1 tree node. 

 

3. From the list of items underneath Page 1, double-click on Gender : LegalValues. The item expands 

to reveal options Before and After (Figure 2.43). 

 

 
Figure 2.43: The expanded options for Gender. 

 

4. Left-click on the after option (Figure 2.44). Notice the Add Block button becomes enabled with the 

phrase Add Block: Gender after. 
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Figure 2.44: Highlighting the after option for Gender. 

 

5. Click the Add Block : Gender after button. This should add a block of code to the Check Code 

Editor window (Figure 2.45). 

 

 
Figure 2.45: The Check Code Editor window after completing Step 7 

 

6. Position the cursor immediately after the line that reads //add code here. 

7. From the Add Command to Field Block pane, left-click on the If command option (Figure 2.46). 

The If command dialog appears (Figure 2.47). 
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Figure 2.46: Selecting the IF command. 

 

 
Figure 2.47: The If Command Dialog. 

 

8. The If command dialog allows you to execute certain commands based upon a condition. Recall the 

condition for the example: If the patient’s gender is male. Since the Gender field stores the value for 

gender that was entered, you need to specify it in the condition. From the Available Variables drop-

down list, select Gender. The If dialog changes to look like Figure 2.48. 
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Figure 2.48: The If Command Dialog after completing Step 10. 

 

9. From the Operators group, click the = button, An = sign is inserted into the If Condition text box. 

10. from the Operators group, click the . A “ is inserted into the If Condition text box. 

11. Place the cursor into the If Condition text box. 

12. Type Male. 

13. From the Operators group, click the “ button. A “ is inserted into the If Condition text box. The If 

command dialog should now appear (Figure 2.49). 
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Figure 2.49: The If Command Dialog after completing Step 15. 

 

14. Our condition has now been set. Specify what actions will be taken when this condition is true. To 

do this, click the         button next to the Then list box. A list of commands will appear (Figure 2.50). 

 
Figure 2.50: Commands available after completing Step 16. 

 

15. From the list, select Goto. The Goto command  forces the cursor to a specified field, so it is ideal to 

use for creating our skip pattern. A Goto command dialog will appear (Figure 2.51). 
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Figure 2.51: The Goto command dialog. 

 

16. Highlight the Ill field (Figure 2.51). 

17. Click the OK button. The If command dialog should re-appear (Figure 2.52). 

 
Figure 2.52: The If command dialog after completing Step 17. 

 

18. Click OK. The Check Code Editor window should appear (Figure 2.53). 
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Figure 2.53: The Check Code Editor after completing Step 18. 

 

19. From the Check Code Editor window toolbar, click 

the Validate CheckCode button.  

20. From the Check Code Editor window toolbar, click 

the Save button. 

21. Click the Close button.  

Congratulations, you’ve created a skip pattern! Before you can 

test it, however, you need to open the form in the data entry module, which will be discussed in the next 

section. 

 

 

Note: The Validate CheckCode button is useful 

for finding syntax errors in the code. If errors are 

found, they will displayed to you in the 

Messages pane at the very bottom of the Check 

Code Editor window. 

Warning! If the next field in the tab order 

also has ‘after’ check code, do not use a 

GOTO for your skip pattern. In this 

scenario, you should HIDE or DISABLE the 

fields in-between the field to be skipped, 

and the field to be skipped to when the 

condition is true. UNHIDE or ENABLE 

them when the condition is false. 
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ENTERING DATA 

OPENING THE DATA ENTRY MODULE 

Data entry in Epi Info™ 7 is fairly straightforward. Like the Form Designer, it is a distinct 

module that we’ll need to open in order to use. Thankfully, the Form Designer makes it very easy to go 

straight to data entry mode: 

1. From the toolbar, press the Enter Data button. A Create New Data Table dialog should appear. 

2. Click the Yes button. A New Data Table dialog should appear. 

3. Leave the default values alone. Click OK. 

The Form Designer will close and the Enter module will appear in several seconds. If you followed all of the 

steps in part two, look at a form similar to Figure 3.1. 

 

Figure 3.1: Your form, ready for data entry! 

The Enter window looks similar to  the Form Designer window: The main panel, or canvas, shows the fields 

you created in part two, while the left-hand side of the window shows you a list of pages that exist for this 

particular form. 

The key difference is that you can now enter data into the fields you created. Buttons at the top of the 

screen  allow you to navigate forwards and backwards through the records (we don’t have any records since 

we just created the form, so these won’t function at the moment), a Find feature to search for existing 

records, a New Record button for manually creating new records, etc. 

4 
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ENTERING DATA 

FIELD TYPES 

If you recall, the Last Name field is a text field and accepts almost any sort of input. In other words, Smith is 

just as valid as abc#(&*(ojio3211. 

The next field, Gender, is Legal Values and the only input that is legal is what appears in the list of choices. 

In this case, only Male and Female will be accepted. 

Following gender is a Yes/No field. Notice how you can select either Yes or No from the drop-down list of 

choices. Unlike the checkbox field, however, you can leave the Yes/No field blank, which represents an 

unknown or missing response. 

The fourth field is a checkbox asking whether the patient was ill. It starts off unchecked, or false. You can 

check the checkbox to give it a value of true, but you can never clear its value. It’s always either true or 

false. 

The last field, Age, is Numeric and only accepts numbers. Because you set upper and lower boundaries on 

what types of numbers it would accept, entering values below 5 or above 80 is not allowed. 

FIELD AND PAGE NAVIGATION 

To move from one field to another, use the mouse or press the Tab key. If you press Tab while you’re on the 

last field on a page, Enter will automatically advance to the next page. If you’re on the last field of the last 

page, then Tab will advance you to page 1 of a new record. 

Additionally, any page in the form can be loaded by clicking on it in the Pages panel on the left-hand side of 

the screen.  

In the previous section, you added some intelligence into the form (e.g., if Male is entered into the Gender 

field, then the cursor will skip past the pregnancy question). Do this now: 

1. From the list of choices I nGender, select Male. 

2. Press tab. The cursor should land in the Ill checkbox. If “Female” is selected instead, then pressing 

tab should move the cursor to the question regarding whether the patient is pregnant. 

Because we have a lot of different fields on page two, let’s navigate to that page: 

1. On the left-hand side of the screen, locate the Pages panel. 

2. From the list of pages, click on Page 2. The Demographics fields should appear (Figure 3.2). 
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Figure 3.2: The ‘Demographics’ fields on page two. 

This template includes several field types not discussed in part two (e.g., date fields, user-defined drop-

down lists, and command buttons). Don’t worry about those for the moment. Enter some data into the 

fields to get a feel for it. 

GEOCODING ADDRESSES INTO LATITUTE/LONGITUDE 

Take note of the Get Coordinates button and the latitude and longitude fields. If you are connected to the 

Internet, Epi Info™ 7 can turn a street address into latitude and longitude. Let’s take a look at how this is 

done. 

1. Type 1600 Clifton Rd. Atlanta, GA 30329, USA into the Address field. 

2. Click the Get Coordinates button. A Geocoding Results dialog should appear (Figure 3.3). 

 
Figure 3.3: The Geocoding Results window after completing Step 2. 

 

3. Click the Accept button. The latitude and longitude for this address (displayed in the Geocode 

Results dialog) will be placed into the form’s Latitute and Longitude fields.  
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GPS coordinates may be helpful to collect, especially if they are displayed on a map. Epi Info™ has some 

built-in mapping capabilities. We’ll discuss more on maps later. For now, let’s show a quick map with the 

single record displayed: 

1. If the geocoding was successful, press the Save button on the Enter toolbar. This will commit the 

record to the database. 

2. From the Enter toolbar, press the Map button. The Map window will appear (Figure 3.4). 

 
Figure 3.4: The Map window. 

 

3. From the toolbar at the top of the Map window, select Add Data Layer > Case Cluster.  

4. Select No when prompted to use external data. A small gadget should appear with Latitude and 

Longitude drop-down lists. 

5. From the Latitude drop-down, select PatientLatitude. 

6. From the Longitude drop-down, select PatientLongitude. (Figure 3.5).  

 
Figure 3.5: Selecting values for the fields. 
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After both drop-down lists have been filled in, the coordinate will be displayed. You may want to switch 

between Street and Satellite depending on your particular mapping needs. This can be done using the 

street/satellite selector in the top-right corner of the map window. Figure 3.6 shows the coordinate 

displayed in Street mode. 

 

 Figure 3.6: The location of the CDC. 
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LINE LISTS 

To show some of the more advanced capabilities of the Enter module, in this case a line listing, we’ll need 

to work with a larger set of data than what we can reasonably enter in a short period of time. Epi Info™ 7 

contains a pre-built E. Coli Food History questionnaire with 359 records, which makes it an excellent 

candidate: 

1. From the Enter toolbar, click the Open Form. An Open dialog will appear (Figure 3.7). 

 
Figure 3.7: The Open form dialog. 

 

2. To open a form in another project, change which project you’re telling Enter to work with. Click 

the browse button next to the Current Project text box. A Select a Project dialog should appear. 

3. From the Projects folder, select the EColi folder. A list of available projects should appear. 

4. From the list, select EColi. The Open dialog shown in Figure 3.7 will change to look like Figure 3.8. 

 
Figure 3.8: The Open form dialog after selecting the HIV project. 

 

5. Because a new project has been opened, select a form within that project to work with.  

6. From the Forms list, select the FoodHistory form. 

7. Click OK. After several seconds, the FoodHistory form will appear in the Enter canvas (Figure 

3.10). All data displayed in this form is fictional and for demonstration purposes only. 
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Figure 3.10: The E. Coli sample questionnaire. 

If you look at the top of the Enter window, you’ll we’re on record 1 of 359. This provides a much larger set of 

records. To show a basic line listing: 

1. Click on the down arrow next to the Line Listing button on the Enter toolbar. A list of line listing 

options should appear. 

2. From the list of choices, select Printable (HTML). An HTML line listing should appear in the 

operating system’s default web browser. 

Keep the E. Coli sample case form open for part four, data analysis. 
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PRINTING A FORM 

From the Enter toolbar, click the Print button to produce a paper copy of your form (Figure 3.11). 

 

Figure 3.11: The Print button, highlighted in blue. 
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ANALYZING YOUR DATA 

INTRODUCTION TO THE EPI INFO™ DASHBOARD 

Epi Info™ 7 provides users with two ways of analyzing data: Through the Classic Analysis 

module and the Dashboard. Analysis is a very powerful command-driven module that has been included 

with almost every past release of Epi Info™ dating back to the 1980s. The Dashboard, a new feature with Epi 

Info™ 7,  is designed to allow epidemiologists to conduct analysis without needing to learn intricate 

command syntax. For the purposes of this guide, we will only use the Epi Info™ 7 dashboard. More 

information on using the command-driven Classic Analysis module can be found in the Epi Info™ 7 User 

Manual. 

To access the dashboard: 

1. If you have not done so already, open the E. Coli questionnaire form discussed in part three. 

2. From the Enter toolbar, click the Dashboard button. The Dashboard window will appear (Figure 

4.1). 

 

Figure 4.1: The Epi Info™ Dashboard. 

The record count at the top-left corner of the Dashboard window should show 359 records. Notice the two 

“gadgets” on the left-hand and right-hand side of the screen. The one on the left is a used for creating new 

variables; the one on the right is a data-filtering gadget. Those gadgets will become more useful later in this 

section. 

5 
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E. COLI FOOD HISTORY QUESTIONNAIRE BACKGROUND 

Before we continue here’s some background on the E. Coli outbreak. You may have seen some of this 

information from the line listing that you displayed in part three, but the form has allowed us to collect 

several interesting pieces of information: 

• Whether the patient was ill. 

• What foods the patient ate. 

• The patient’s date of birth and age. 

• The patient’s gender. 

All of the data was created specific to the town of Uelzen, Germany. Additionally, the data associated with 

this form are entirely fictional and was created to demonstrate some of the program’s analytic capabilities. 

ANALYSIS USING GADGETS 

All of the analysis in the dashboard is done using gadgets. Three gadgets (record count, data filtering, and 

data recoding and formatting) always appear by default. You can add more, but never close those three. 

LINE LISTS 

Let’s create a traditional line list of the data. 

1. Right-click on the dashboard. A pop-up context menu will appear. 

2. Select Add Analysis Gadget > Line Listing (Figure 4.2). A line list gadget will appear on the 

dashboard canvas (Figure 4.3). 

 
Figure 4.2: Adding a Line List gadget. 
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Figure 4.3: The line list gadget. 

 

3. No fields are currently selected for display in the list. You must choose the fields you want to show. 

In the List variables to display list box, CTRL+Left-click on the Age, CaseID, DOB, FeverTemp, 

ILL, and Sex fields. (The CTRL+Left-click combination will allow you select multiple fields at 

once). 

4. Click the Generate Line List button. The list is generated (Figure 4.4). 

 

 
Figure 4.4: The line list of the fields CaseID, Sex, DOB, Age, Ill, and FeverTemp. 
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Note the yellow warning at the top of the output. By default, the line list will only show the top 200 rows; 

the row limit exists to improve performance when working with large data sets. It can be modified in the 

Line List Properties panel. 

SORTING A LINE LIST 

The list data is not sorted in any particular order in the example above. To sort the list by date of birth: 

1. In the Line List Propertiespane, click on the Expand arrow (Figure 4.4). The Line List Properties 

panel expands to show the full set of properties for the line list gadget (Figure 4.3). 

 
Figure 4.5: The expand arrow. 

 

2. In the Sort Variables drop-down list, select DOB. The DOB field will appear in the Sort Order list 

with (ascending) next to its name. 

3. In the Sort Order list, right-click on the DOB (ascending) item. A context menu will appear 

(Figure 4.6). 

 

 
Figure 4.6: Right-clicking on an item in the Sort Order list. 

 

4. Select the Change ascending/descending option. The DOB (asending) text changes to DOB 

(descending). 

5. Click the Generate Line List button. Notice that the output is now sorted by date of birth in 

descending order. 

Multiple fields can be added to the Sort Order list box. The order of precedence for the sort will go from the 

first to the last field listed. 

EXPORTING A LINE LIST 

Once created, the line list data may be copied to the clipboard, exported to Microsoft Excel or the 

computer’s default web browser. To export the line list data to Excel, follow the steps below. Note that you 

must have Excel installed to see this feature. 

1. Right-click on the line list. A context menu will appear (Figure 4.7). 
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Figure 4.7: Right-clicking on the line list. 

 

2. Select the Send list data to Excel menu option. In several moments, the list data appears in a 

Microsoft Excel spreadsheet (Figure 4.8). 

 

Figure 4.8: The line list data in Microsoft Excel 2010. 
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OTHER LINE LIST FEATURES 

The line list has several other notable features in the properties panel: 

� The Group Results By drop-down list allows the list output to be stratified by another field on the 

form. For example, if you want separate line lists for males and females. 

� The Max Variable Name Length text box allows truncating long column names in the list output. 

It is set to 24 by default. 

� The Max Rows to Display text box allows changing the maximum number of rows that the line 

list gadget will display. It is set to 200 by default. 

� The Sort Variables by Tab Order checkbox forces the columns in the output to be sorted by their 

tab order. It is off by default. 

� The Use Field Prompts checkbox will use the field’s prompt as the column heading, rather than 

the field’s name. It is off by default. 

� The Display List Labels checkbox will use the label value for option fields and comment legal 

fields rather than the underlying value stored in the database. Option fields and comment legal 

fields are discussed further in the Epi Info™ 7 User Manual.  
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FREQUENCIES 

Let’s show a simple frequency of gender to see how many male and female patients we have: 

1. Right-click on the dashboard. A pop-up context menu should appear. 

2. Select Add Analysis Gadget > Frequency (Figure 4.9). A frequency gadget should appear on the 

dashboard canvas. 

 
Figure 4.9: Adding a Frequency gadget. 

 

3. In the Frequency gadget, select Sex in the Field drop-down list (Figure 4.10). After you choose a 

field, the gadget updates with the results (Figure 4.11). 

 
Figure 4.10: Selecting a field to run a frequency on. 

 

 

 
Figure 4.11: The frequency of sex among our 359 cases 

Note that the frequency data (Figure 4.11) can be exported directly to Excel in the same manner as was done 

for the Line List gadget. 
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MEANS 

The Dashboard also allows for the generation of summary statistics for numeric data (e.g., the mean, 

median, maximum, minimum, and mode). To find the mean fever temperature: 

1. Right-click on the dashboard. A pop-up context menu should appear. 

2. Select Add Analysis Gadget > Means. A means gadget should appear on the dashboard canvas. 

3. In the Means gadget, select FeverTemp in the Field drop-down list. After you choose a field, the 

gadget updates with the results. 

 

 
Figure 4.12: Summary statistics for the FeverTemp field. 

The statistics shown in figure 4.12 can be broken down further by using the Cross-tabulate by drop-down 

list. To cross-tabulate by males and females: 

1. In the means Properties panel, click the expand arrow . 

2. In the expanded Means Properties panel, click the Advanced options text. 

3. In the Cross-tabulate by drop-down list, select Sex The means gadget updates to show the fever 

temperature data broken down by males and females. 

 

Figure 4.13: Summary statistics for the FeverTemp field broken down by males and females. 

Similar to the frequency and line list data, the means data can be exported directly to Excel. 
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2X2 TABLES 

2x2 tables can be generated using the 2x2 gadget. Our questionnaire had several checkboxes for the various 

foods that may have been consumed. We can select one of these checkboxes to be the exposure and use the 

Ill field as the outcome. 

1. Right-click on the dashboard. A pop-up context menu should appear. 

2. Select Add Analysis Gadget > 2x2 Table. A 2x2 table gadget should appear on the dashboard 

canvas. 

3. In the 2x2 table gadget, select Strawberries in the Exposure drop-down list. 

4.  In the 2x2 table gadget, select Ill in the Outcome drop-down list. After both drop-down lists are 

filled in, the gadget updates with the results (Figure 4.14). 

 

Figure 4.14: A 2x2 table showing strawberries by ill. Whether the patient ate strawberries is the exposure, and 

whether the patient became ill is the outcome. 

The results displayed in Figure 4.14 are useful, but there are quite a few checkboxes in the Foods Eaten 

group on page 2. It would take considerable time to add a gadget for each one of the foods listed. Because 

we have a group field surrounding all of the checkboxes, we can run the 2x2 statistics on the entire group.  
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To run the grouped analysis: 

• Change the Exposure field to FoodsEaten. Because FoodsEaten is a group, it will appear at the 

bottom of the list of fields. 

 

Figure 4.15: A grouped 2x2 result. The FoodsEaten group was specified as the exposure, and whether the 

patient became ill was specified as the outcome. 
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In Figure 4.15, note the relative risk chart that appears above the 2x2 results. Each row in the chart 

represents one of the checkboxes in the FoodsEaten group. Clicking on a particular row will change the 2x2 

results shown in the lower half. The chart is sorted by risk ratio by default. Notice that BreanSprouts has the 

highest risk ratio. 

It’s important to note that the grouped 2x2 table was made possible because of the  form’s design: The field 

that stored whether or not the patient became ill was a Yes/No field, meaning it could only store a yes, no, 

or a missing (unknown) value. Each of the foods consumed was represented by a checkbox, meaning that 

only a yes or no response was valid. All exposure fields were placed into a single group field.  

You are encoouragedto use checkbox fields and Yes/No fields for questions that can only take a yes or a no 

response. This will make analysis much simpler. Intelligent use of groups can enable faster and more 

productive analysis. 

 

DATA RECODING 

A checkbox field or Yes/No field, however, is not adequate for data collection. Let’s take the age field as an 

example: 

1. From the dashboard canvas, select the Frequency gadget. 

2. In the Field drop-down list, select Age. 

The frequency output shows all the age values in the data set. This probably is not useful for our purposes.  

Age groupings or categories would be more helpful. Fortunately, the dashboard provides such a capability. 

1. On the left-hand edge of the Dashboard canvas, move the mouse cursor over the Defined 

Variables gadget. The gadget will expand and become fully visible. 

2. Click the New Variable button. 

3. Select With Recoded Value when prompted. The Add Recoded Variable window should appear 

(Figure 4.16). 
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Figure 4.16: The recoding window. 

 

4. From the Source field drop-down list, select Age . Leave the other choices at their default settings. 

5. Click the Fill Ranges button. The Fill Ranges dialog appears. 

6. Select 0 for the start value, 65 for the end value, and 10 for the by value (Figure 4.17). 

 

 
Figure 4.17: The Fill Ranges window. 

 

7. Click OK. The Add Recoded Variable window should become populated with a series of range 

values (Figure 4.18). 
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Figure 4.18: The recode variable window after completing Step 7. 

 

8. Click OK. The recoding of the variable is now applied. 

9. From the frequency gadget’s Field drop-down list, select Age_RECODED. The frequency output 

should appear (Figure 4.19). 

 

Figure 4.19: The frequency gadget’s output after completing Step 9 

Recoding can be a powerful tool; in addition to being able to create numeric ranges, we can also change 

coded values (e.g., 0 and 1 into meaningful text values that include male and female). You can also recode a 

series of data from multiple values to just two values. Now they can be showed in a 2x2 table. 
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CHARTS 

The dashboard is not limited to creating data tables. Charts and graphs can also be created. While many 

chart types are available, this guide will cover the pie chart and epi curve. 

PIE CHARTS 

Let’s generate a pie chart of our recoded age groups: 

1. Right-click on the dashboard. A pop-up context menu should appear. 

2. Select Add Analysis Gadget > Chart. A chart gadget should appear on the dashboard canvas.  

3. From the Chart Type drop-down list, select Pie. 

4. From the Chart gadget, select Age_RECODED in the Primary Field drop-down list. 

5. From the Chart Size drop-down list, select Large. 

6. Click the Generate Chart button. 

 

Figure 4.20: The pie chart showing the recoded age categories. 

Once created, charts have their own special right-click context menu that provides additional options for 

configuring and saving the charts.  

Set/Change Labels – allows you to create or modify the chart’s title, axis 

labels, and legend title. 

Save chart as image – allows you to save the chart as an image. 

Copy to clipboard – allows you to copy the image to the clipboard for 

easy pasting into other applications (e.g., Microsoft Word,  PowerPoint). 

Print – allows you to directly print the image. 
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EPI CURVE CHARTS 

Generate an epi curve using the OnsetDate field. 

1. Right-click on the dashboard. A pop-up context menu should appear. 

2. Select Add Analysis Gadget > Chart. A chart gadget should appear on the dashboard canvas.  

3. From the Chart Type drop-down list, select Epi Curve. 

4. From the Onset Date Field drop-down list, select OnsetDate. 

5. From the Date Interval drop-down list, select Days. 

6. Click the Generate Chart button. 

 

Figure 4.21: The epi curve of the date of symptom onset. 

The data for this outbreak is fictional and somewhat random. The data may not actually appear to resemble 

a proper epi curve. 
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DATA FILTERING 

It is not always practical to work with the entire set of records in the data set. What if you want to show a 

frequency of age categories (which you created in the last section by recoding the age field), but only for 

patients that were actually sick? To accomplish this, you need to use the Data Filter gadget: 

1. From the right-hand edge of the dashboard canvas, move the mouse over the Data Filter gadget. 

The gadget should expand outwards. 

2. From the Field Name drop-down list, select Ill.  

3. From the Operator drop-down list, select is equal to. 

4. From the Value drop-down list, select Yes. 

 
Figure 4.22: The data filtering gadget after completing Step 4. 

 

5. Click the Add Filter button. The filter condition is added to the Data filters grid view (Figure 4.23).  

 
Figure 4.23: The data filtering gadget after completing Step 5. 

If a filter condition is added or removed, any gadget on the canvas will automatically refresh. The record 

count in the top-left corner of the dashboard canvas now reads 276, indicating that we’re working with 276 

out of 359 records where the value of ILL is Yes. 

Let’s assume you want to only work with records where patient was ill and between 20 and 29 years of age. 

Take the following steps: 

1. On the right-hand edge of the Dashboard canvas, move the mouse over the Data Filter gadget. The 

gadget should expand outwards. 
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2. From the Field Name drop-down list, select Age.  

3. From the Operator drop-down list, select is between. 

4. From the Value text boxes, type in 20 for the first box. 

5. From the Value text boxes, type 29 for the second box. 

 
Figure 4.24: The data filtering gadget after completing Step 4. 

 

6. Click Add Filter. A context menu appears asking if you want to add this condition using an AND or 

an OR. 

7. Select the AND option. The filter condition is added to the Data filters grid view beneath the first 

condition. 

The record count shows 64 records. Only 64 records match the two filter criteria that have been 

established. The patient must have been tested and be from 20 and 29 years of age. Any gadgets added to 

the dashboard canvas will only display data from these 64 records. 

1. Add a frequency gadget. 

2. Select Age or Age_RECODED as the field. Notice how the values displayed are only within the 

range specified and that the total in the frequency is small. 

Clear the data filters to continue working with the full set of records again. To do this: 

1. On the right-hand edge of the dashboard canvas, move the mouse over the Data Filter gadget. It 

should expand outwards. 

2. Select the second condition, which should appear as “The value of Age is between 20 and 29.” 

3. Click the Remove Selected button. The condition disappears. 

4. Select the only remaining condition. 

5. Click the Remove Selected button. The condition disappears.  
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SAVING THE DASHBOARD CANVAS 

It might be useful if you could capture the gadgets displayed in the dashboard and re-loaded them again at 

a later date. This would prevent you from having to re-create all of the recoded variables, data filters, and 

gadgets each time you want to conduct analysis. 

It might also be useful if you could save the output from the dashboard into a file that you could e-mail to 

colleagues or co-workers. 

Fortunately, the Epi Info 7 Dashboard has methods to perform both tasks: 

• The current data source and set of gadgets, filters, and user-defined variables can be saved to a 

‘Canvas file on the hard drive. You can open Canvas files from within the dashboard. 

• The output from each gadget can be saved to an HTML file. HTML files can be opened in any web 

browser and can be e-mailed to colleagues or turned into a PDF document.  

Let’s start with saving the current set of gadgets and user-defined variables. 

1. Ensure the dashboard you’re viewing has at least the following gadgets: A frequency of Sex, a means 

of fever temperature, a line list, a chart of the recoded age field, and a 2x2 table showing 

Strawberries by ILL. It should look like Figure 4.25. 

 
Figure 4.25: The dashboard at Step 1. 
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2. From the dashboard window toolbar, click the Save       button. A Save dialog will appear asking 

you to provide a name for an Epi Info 7 Canvas file (Figure 4.26). 

3. Select your desktop as the location to save the file. 

 
Figure 4.26: The Save Canvas dialog. 

 

4. Type QuickStartGuide into the File Name box.  

5. Click the Save button. A message should appear indicating that the save was successful. 

After completing Step 5, the dashboard has been saved; any gadgets, filters, or user-defined variables have 

been stored to the QuickStartGuide.cvs7 file on your desktop.  Only the Epi Info 7 Dashboard may open 

this file. 

To load the file: 

1. Close the dashboard window. 

2. Open the E. Coli food history questionnaire, which should still be open in the Enter module in 

another window. 

3. Click the Dashboard button on the Enter toolbar. The Dashboard window should appear. 

4. Click the Open        button on the Dashboard toolbar. You should see an Open dialog.  

5. From the desktop,  highlight the file named QuickStartGuide.cvs7. 

6. Click the Open button. The dashboard should re-appear with the same output as shown above. 

The file you just saved and loaded only contains information about the gadgets, filters, defined 

variables, and data source. It uses this information to load the gadgets using whatever data source was 

defined (in this case, it was our HIV case report form). It does not store the actual output; the next 

section discusses procedures for saving the results you’re seeing. 
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SAVING THE DASHBOARD OUTPUT 

If you want to e-mail your results to a colleague, you can store the output from the gadgets into an HTML 

document. Unlike the canvas file you saved and opened in the last section, the HTML document can only 

be opened in a web browser; it cannot be used to re-create the dashboard’s canvas. 

To save the current output: 

1. From the Dashboard toolbar, click the Save as HTML  button. A Save dialog should appear. 

2. Select your desktop as the location to save the file. 

3. Type FoodHistoryOutput into the File Name text box (Figure 4.27). 

 
Figure 4.27: The Save as HTML dialog. 

 

4. Click the Save button. A message should appear stating that the save was successful. 

5. Minimize all Epi Info 7 windows and navigate to your desktop. 

6. Locate the file named Output1 (Figure 4.28). 

 
Figure 4.28: The file ‘FoodHistoryOutput.html’ on the desktop. 

 

7. Double click on the FoodHistoryOutput file. A web browser window should appear with results 

similar to Figure 4.28. 
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Figure 4.28: The file ‘FoodHistoryOutput.html’ shown in an Internet Explorer window. 
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CREATING MAPS 

In part three, you geocoded an address into GPS 

coordinates and subsequently showed those 

coordinates on a map. With the E. Coli sample case data, all 359 

records have their own latitude and longitude coordinates – 

meaning you can quickly display them without needing a lot of geocoding. 

1. Navigate back to the Enter window. You can leave the dashboard open. 

2. With the Food History form still open, click the Map button on the Enter toolbar. The Map 

window will appear (Figure 5.1). 

 
Figure 5.1: The Map window. 

 

3. From the toolbar at the top of the Map window, select Add Data Layer > Case Cluster. 

4. Select No when prompted to use external data. A small gadget should appear with Latitude and 

Longitude drop-down lists. 

5. Select Latitude for the Latitude drop-down list. 

6. Select Longitude for the Longitude drop-down list. The map will zoom in to the area around the 

coordinates. 

7. On the top-right corner of the map window, select Street. 

After completing Step 7, you should see something similar to Figure 5.2. Unlike in part three, however, 

there are many more points to view. Large clusters of cases appear as bigger circles with the total case count 

contained inside of them. 

Tip: Data filtering works in the mapping 

window the same way it does in the 

dashboard. 

6 
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 Figure 5.2: The case cluster map of HIV cases. 

Use the mouse wheel to zoom in on the center of Uelzen where the 359 cases are located. The view of cases 

becomes far more detailed. Individual cases appear as single red dots without any number inside of them. 

Case clusters appear as dots with a number inside, indicating the number of cases in that cluster. 

What if you see a case on the map that you want to investigate further? You can double-click on any dot 

representing a single case to take you directly to that record in the Enter module. 

You can also move the mouse over a small case cluster (less than 12 records), which causes the cases in that 

cluster to flare outwards (Figure 5.4). 

 

Figure 5.4: A flared case cluster. 

Notice that this case cluster dot has a 6 in its center representing six cases. If you move the mouse over it, 

six smaller dots appear, each representing one of the six records inside of that dot. You can click on any of 

those dots to take you to that particular record in the Enter module. 

More advanced options are available for mapping, including data filtering, stratifying the cases (i.e., 

showing white patients as green dots and Asian patients as yellow dots), displaying choropleth maps with 

census data behind the case clusters, etc. 
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DATA FILTERING IN MAPS 

The key concept to remember when creating maps in Epi Info 7 is that everything is based on the concept 

of layers. Each layer may have its own set of data  and have its own set of data filters. 

For example, we can show one layer with a case cluster representing our HIV patients, and another 

underneath that displaying poverty rates by Census Tract. You can also use layers to create stratified maps 

to show male HIV cases in one color, and female HIV cases in another. 

Much of the power of layers comes from using data filters on each layer’s respective data set. You can apply 

one set of filters to one layer and another set of filters to a different one.  

Let’s start with something simple. You only have one layer at the moment, the one just added using HIV 

case data. It includes all 359 records. Assuming you only want to map cases where the patient’s age is lower 

than 21, how do you apply such a filter? 

1. From the very bottom of the map window, move the mouse over the Map Layers gadget. The Map 

Layers gadget will expand upwards (Figure 5.5). 

 
Figure 5.5: The Map Layers gadget. 

 

2. Click on the Data Filters button (the button with the funnel-shape on the right-hand side of the 

gadget). A Data Filters gadget will appear (Figure 5.6), the same gadget you used in the Dashboard 

section of this document. 

 
Figure 5.6: Data Filters. 

 

3. From the Field Name drop-down list, select Age. 

4. from the Operator drop-down list Select Is Less Than. 

5. Type 21 into the Value text box. 

6. Click the Add Filter button. The case clusters on the map should change. The filter gadget should 

display one row in the Data Filters table (Figure 5.7). 
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Figure 5.7: The Map window after completing Step 6. 

 

7. To close the gadget, click the X button.  

You are now observing only the cases where a  patient is less than 21 years of age. What if you want to show 

both these cases and 21-and-older cases, but show the 21-and-older cases in a different color? In other 

words, you want to stratify the case clusters by whether the patient is under 21. 

You need another layer. The first layer, which is the one showing currently in Figure 5.7, has a filter applied 

that says, “Only show the records where the age is less than 21.” Add a second layer with blue-colored dots, 

but this layer will have a different filter applied; it will only show the records where the age is greater than, 

or equal to 21. 

1. From the toolbar at the top of the Map window, select Add Data Layer > Case Cluster. 

2. Select No when prompted to use external data. A small gadget should appear with Latitude and 

Longitude drop-down lists. 

3. Before selecting Latitude and Longitude, click the red Point Color button to change the layer’s 

color to blue. 

4. To bring up the Data Filters gadget, click the Data Filters button. 

5. From the Field Name drop-down list, Select Age. 

6. From the Operator drop-down list, select Is Greater Than or Equal To. 

7. Type 21 into the Value text box. 

8. Click the Add Filter button. 
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Figure 5.8: The Data Filters gadget after completing Step 8. 

 

9. To close the Data Filters gadget, click the X at the top-right corner of it. 

10. From the Latitude drop-down menu, select Latitude. 

11. From the Longitude drop down menu, select Longitude. The map should zoom in to the area 

around the coordinates (Figure 5.9). 

 

Figure 5.9: The Map window after completing Step 11. 

Figure 5.9 contains a stratified map; the blue dots represent cases where the patient is 21 years of age or 

older, while the red dots represent cases where the patient is less than 21. You could have set the stratified 

by other variables (e.g., whether the patient is male or female, has only HIV or HIV and AIDS, if the  viral 

load exceeded a certain amount, etc.). 

The Map Layers gadget at the bottom of the screen shows a (2) instead of a (1) as it did previously. This is 

because you created two different layers: one for the younger-than-21 cases, and another for those 21-and-

older. 
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APPENDIX A: EPI INFO™ 7 BEST PRACTICES 

There are several “best practices” that, if followed, can make using Epi Info™ much easier. 

 

1. When creating fields in the Form Designer, the Field Name you choose will become what you 

reference the field by when conducting analysis (e.g., in the dashboard). Create short and easy to 

understand field names. 

 

2. Once you have created a data table for your form  (entering data into the form),  you can no longer 

change field names unless you delete the collected data. You can delete the collected data for a 

form by opening it in the Form Designer and selecting Tools > Delete Data Table from the menu. 

 

3. Always use the Range property for numeric and date fields to help prevent incorrect or invalid 

input. This property can be set in a field’s Field Definition dialog box. 

 

4. Checkboxes and Yes/No fields are good choices for questionnaire responses that must be true or 

false. However, a checkbox field can only be true or false; a Yes/No field can be true, false, or left 

blank. 

 

5. When creating 2x2 tables in the dashboard, only fields that contain (at most) two possible values 

will be available. Checkboxes and Yes/No fields are ideal for 2x2 tables. You can use the Recoding 

gadget to change a field’s data into a true/false format to display a 2x2 table. 

 

6. If you have a numeric field (e.g., Age) and use the Recoding gadget to show the values in categories. 

 

7. In the dashboard, pay attention to gadget warnings and errors that appear above the output. 

Warnings appear in yellow, errors in red. 
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